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	Agena MassArray SARS-CoV-2 Assay 


	
Purpose
	
This procedure provides instructions for preparing samples and reagents, setting up the multiplex reverse transcription polymerase chain reaction (RT-PCR) and Matrix-Assisted Laser Desorption Ionization Time-of-Flight Mass Spectrometry (MALDI-TOF) reactions to perform the Agena Bioscience MassArray SARS-CoV-2 assay (SC2) on Nasopharyngeal (NP) and Nasal swabs in VTM.  


	
Policy Statements
	
This procedure applies to all technical staff performing testing on the Agena MassArray instrument. 


	
Principle and Clinical Significance

	
SARS-CoV-2 (also called COVID-19 virus) is a beta coronavirus belonging to the family of Coronaviruses, named for the crown- like spikes on their surface. There are four main sub-groupings of coronaviruses, known as alpha, beta, gamma, and delta. Common human coronaviruses are 229E (alpha coronavirus), NL63 (alpha coronavirus), OC43 (beta coronavirus) and HKU1 (beta coronavirus), and these usually cause mild to moderate upper-respiratory tract illnesses, like the common cold.  Other human coronaviruses such as MERS-CoV (the beta coronavirus that causes Middle East Respiratory Syndrome, or MERS) and SARS-CoV (the beta coronavirus that causes severe acute respiratory syndrome, or SARS) have caused more severe respiratory illness with higher rates of morbidity and mortality. The SARS-CoV-2 is a novel coronavirus that causes coronavirus disease 2019, or COVID-19. SARS-CoV-2 caused an outbreak beginning in December 2019 in Wuhan City, Hubei Province, China and has spread globally, being consequently declared a pandemic by the World Health Organization (WHO).  Patients with COVID-19 have had mild to severe respiratory illness with symptoms of fever, cough and shortness of breath, and many patients have had complications including pneumonia in both lungs.1-7 SARS-CoV-2 RNA is generally detectable in upper respiratory and bronchoalveolar lavage (BAL) samples during the acute phase of infection.7  


The SARS-CoV-2 Panel for use on the MassArray system, is a multiplex Reverse Transcription Polymerase Chain Reaction Matrix-Assisted Laser Desorption Ionization – Time of Flight (RT-PCR/MALDI-TOF) test intended for the qualitative detection of nucleic acid from Severe Acute Respiratory Syndrome Coronavirus 2 (SARS-CoV-2).  Clinical sample types validated include nasopharyngeal (NP) and nasal swabs (NA) in viral transport media (VTM).  A magnetic bead based nucleic acid extraction on the BioMerieux EasyMag instrument or the Thermo Fisher KingFisher (200uL sample input and 60 uL elution) is utilized for nucleic acid extraction.  

After RNA extraction, RT-PCR with iPLEX Pro chemistry then amplifies target regions of interest; after the inactivation of unincorporated dNTPs, a sequence-specific primer extension step is performed using the supplied Extend primers and iPLEX Pro reagents.  Sample amplification is carried out on the Applied Biosystems 2720 Thermal Cyclers following the parameters listed in the SC2 Panel IFU.  

The extension products (analyte) are desalted, transferred to a SpectroCHIP Array (a silicon chip with pre-spotted matrix crystal) and then loaded into the MassARRAY Analyzer (a MALDI-TOF mass spectrometer).  The analyte/matrix co-crystals are irradiated by a laser, inducing desorption and ionization.  The positively charged molecules accelerate into a flight tube towards a detector.  Separation occurs by time-of-flight, which is proportional to the mass of the individual molecules.  After data processing, a spectrum is produced with relative intensity on the y-axis and mass/charge on the x-axis.  Data acquired by the MassArray analyzer is processed by MassArray Typer software, and then the SC2 Report software which automatically interprets the results.8   

The Agena Bioscience SC2 panel consists of 5 assays targeting the genome of SARS-CoV-2: three probe the viral nucleocapsid (N) gene and two probe ORF1 and ORF1ab.  The panel also contains an MS2 phage assay; an internal control that monitors RNA extraction.7  See Table 1 for details. Two or more targets must be detected for the result to be interpreted as detected (positive).    

Table 1: Panel Targets 
	Assay Name
	Region

	SC2-N1
	Nucleocapsid 

	SC2-N2
	Nucleocapsid

	SC2-N3
	Nucleocapsid

	SC2-ORF1
	ORF1

	SC2-ORF1ab
	ORF1ab





	
Test Code

	
COVID – Nasopharyngeal (NP) and Nasal swabs (Anterior Nares, NA)


	
Sample
	
1. Acceptable specimens: 
0. Nasopharyngeal (NP) swabs: Mini-tip flocked swabs placed in 3 mL VTM 
0. Nasal swabs (anterior nare) (NA): Flocked swabs placed in 3 mL VTM 

1. Unacceptable specimens: Improperly labeled or unlabeled samples. Calcium alginate swabs, other body fluids, other swabs, other respiratory samples.
1. Specimen Collection and Transport:
2. Refer to Lab Test Directory on StarNet
1. Specimen assessment:
3. Refer to the policy MCVI 2.1 Specimen Rejection Criteria
1. Specimen Storage:
4. Specimens should be refrigerated (2-8°C) up to 7 days 

	
Special Safety Precautions

	
· Standard precautions. Refer to MB 2.02 Biohazard Containment
· Use of engineering controls: Refer to MB 3.01 Engineering Controls to Prevent Nucleic Acid Contamination
Laboratory staff are subject to occupational risks associated with specimen handling. Refer to the safety policies located in the safety section of the Microbiology, Virology, and Molecular Policy Manual:
· Safety in the Microbiology/Virology Laboratory
· Safe Work Practices in Molecular 
· Biohazardous Spills
· Biohazardous Spill in Molecular
· Biohazard Containment

1. Wear appropriate personal protective equipment (PPE) including disposable gloves and lab coats.
2. Handle all samples and waste materials as if they were capable of transmitting infectious agents.
3. Change gloves often when handling reagents or samples.
4. Dispose of materials used in this assay, including reagents, used buffer vials in biohazardous waste.


	Materials
	
	Reagents
	Supplies
	Equipment

	-Sani-Cloth Bleach wipes or 1:10 diluted bleach solution
-70% alcohol
-5% Extran
-DNA Away
-Deionized water
-Nuclease Free Water (NFW)
-Clean Resin
-HPLC-grade water
-Negative control – VTM – store at 2 – 8 °C
-Positive Amplification Control material: Twist Bioscience Synthetic SARS-CoV-2 RNA Control 1 (#102019) - store at – 70 °C
-Low Positive control material: ZeptoMetrix SARS-CoV-2 Culture Fluid (Heat Inactivated) (0810587CFHI) – store at – 70 °C
-EasyMag Extraction reagents: Buffers 1-4 and Silica (buffer 3 and silica stored in fridge, other reagents at room temp)
-KingFisher Extraction reagents: MagMax Viral Pathogen Kit II (stored at room temp)
-80% ethanol

Room 1:
MassArray SARS-CoV-2 Panel Kit
-Agena SARS-CoV-2 Panel (REF 12379F) – store at -25 °C to -10 °C:
· SC2 PCR Primers
· SC2 Panel Extend Primers
· UNG (heat labile)
· MMLV Enzyme
· RNase Inhibitor

-PCR Reagent Set with dUTP -  store at -25 °C to -10 °C:
· MgCl2, 25mM
· 10x PCR Buffer
· dUTP/dNTP Mix
· PCR Enzyme

-iPLEX Pro Reagent Set - store at -25 °C to -10 °C:
· 3 Point Calibrant
· iPLEX Termination Mix
· iPLEX Buffer Plus, GPR
· iPLEX Pro Enzyme
· SAP Buffer
· Shrimp Alkaline Phosphatase (SAP)

Room 2:
· MS2 phage internal control 

NOTE: The MassArray SARS-CoV-2 Panel Kit can be used up to ten times (freeze/thaw), as long as components are maintained on ice or a cold block during access and returned to storage conditions after use.  

NOTE: Keep all reagents in cold blocks once thawed and  only take enzymes out of freezer immediately prior to use.  Mark white board for each freeze-thaw cycle. 
	-Gloves (powder-free)
-Filtered pipette tips, various sizes including 200 uL, extended tips
-Sharps disposal container
-Greiner strip plates 
-Microtubes 
-Clear adhesive plate seals
-96 well semi-skirted, color microtiter plates
-0.2 mL PCR strip tubes (8)
-Pipette reservoirs 
-EasyMag consumables
-Kingfisher consumables 
 

	-Plate centrifuge
-Vortex
-Mini tube centrifuge 
-Tube centrifuge 
-Thermocycler
-PCR work station with UV irradiation
-Multichannel pipettes
-Single channel Pipettes 
-Tube racks 
-Sealing paddle 
-Pipeting reservoirs
-SpectroCHIP arrays
-10 to -30° C freezers
-Laminar flow Hood
-Refrigerators 2 – 8° C
-BSC BSL-2
-70⁰  C freezer
-Agena MassArray with Chip Prep Module (CPM) 96, including:
· Typer software v5.01 or greater
· RT-Workstation v4.1 or greater
· Chip Prep Controller v2.2 or greater 




Record shipment receipts on log: MB 15.0.F1 Agena SARS-CoV-2 Kit and QC Inventory Log

	

	Calibration
	
Annual instrument function check and maintenance performed by Agena BioScience.   


	
Quality Control

	
Daily Quality Control:
An internal quality control is included in each patient samples and negative control to monitor the extraction process (MS2 Phage).  The internal control must be valid in order to obtain valid negative patient results.  A valid internal control result is not required for valid positive results. 

External Quality Control:
· Perform QC using external positive and negative controls with every run.
· Perform QC using a previously tested positive and negative patient samples, positive QC (PC), low positive QC (LPC), and negative controls with new lot/shipments. 
· Record and file results in the appropriate binder. 


· Positive Amplification QC – Prepped from Twist Bioscience Synthetic SARS-CoV-2 RNA Control 1 (#102019) - store at – 70 °C
· Low Positive QC (LPC) – Prepped from ZeptoMetrix SARS-CoV-2 Culture Fluid (Heat Inactivated) (0810587CFHI) – store at – 70 °C
· Low Positive Control: ~10x LOD
· Negative QC (NC) – VTM, stored at 2-25°C
· An Internal Control (IC) is incorporated into each patient sample and negative control to monitor the extraction process (MS2 Phage)

QC Monitors:
	Control
	Control Monitor

	Historical Positive and Negative Patient Samples
	Reagent, instrument, equipment, or supply failure.

	Positive Amplification Control (PC)
	Reagent, instrument, equipment, or supply failure.

	Low Positive Control (LPC)
	Challenges the Limit of Detection.  Reagent, instrument, equipment, or supply failure.

	Negative Control (NC)
	Reagent, instrument, equipment, or supply failure.  Environmental contamination monitoring.

	Internal Control (IC)
	PCR inhibition in specimen, reagent failure or process error.



Record QC results on worksheet and log:
MC 15.0.F1 Agena SARS-CoV-2 Kit and QC Inventory Log
MB 15.0.F2 Agena SARS-CoV-2 New reagent QC worksheet
MB 15.0.F3 Agena SARS-CoV-2 QC Log

· Before reporting patient results, all controls must yield valid results
· NOTE: a valid positive result does not require an IC result
· If results are invalid, repeat testing

Preparing Negative Control (NEGC)
1. Wear lab coat and gloves dedicated to the Clean room 1
2. Label cryo-storage box with contents 
3. Lot number (L/N), expiration date and date of preparation
4. Aliquot 300 µl of VTM into 1.5 micro tubes
5. Refrigerate aliquots (2 – 8 °C) in room 2
6. Record lot information in appropriate binder

Preparing Positive Controls (POSC) 
Refer to:  
MB 15.1 Agena MassArray SARS-CoV-2 Assay Quality Control Preparation
MB 15.0.F5 Agena MassArray SARS-CoV-2 Positive Control Prep Worksheet

Test controls as you would patient samples.

Record and file results in QC binder

Expected Control Results

	Control Type
	Expected Results
	SC2-N1 target
	SC2-N2 target
	SC2-N3 target
	SC2-ORF1 target
	SC2-ORF1ab
	MS2 Phage Internal Control1

	Historical Positive and Negative Patient Samples
	Match to historical qualitative results

	POSC: Positive Amplification Control*
	SARS-CoV-2 Detected
	Detected
	Detected
	Detected
	Detected
	Detected
	Not applicable1

	Low POSC: Low Positive Control
	SARS-CoV-2 Detected**
	Detected
	Detected
	Detected
	Detected
	Detected
	Not applicable1

	NEGC: 
VTM*
	SARS-CoV-2 Not Detected
	Not Detected
	Not Detected
	Not Detected
	Not Detected
	Not Detected
	Detected


1. Detection of the MS2 Phage Internal Control (RNA IC) is not required for a valid result when ≥2 SARS-CoV-2 targets are detected.  The amplification control does not contain MS2. 
*Run report will indicate “QC Status Passed” if results match according to the table
**Required qualitative result, all genes detected, not required for control to pass


NOTE: When reagents are in use update the information on the reagent run prep worksheet.

Wipe testing:
· Perform wipe testing every 30 days to monitor for contamination. 
· See MB 3.02 Wipe Testing for Amplicon Contamination

NOTE: Additional external quality control may be performed on an as needed basis if certain circumstances arise.  Examples include:
1. Drift in results (e.g., increasing/decreasing positivity rates)
1. Potential contamination (negative control)
1. After dramatic instrument maintenance or movement


	Assay Procedure: Sample Preparation and Extraction (Room 2)
	
NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by water and alcohol before and after any sample processing 



Testing Preparation – Sample prep and RNA extraction: Room 2
1. Make a manual worksheet for COVID; use this worksheet for sample identification throughout testing.
NOTE: Label the worksheet with your Experiment/Run name:  “date SC2 run and run #”
a. e.g. March 3, 2020, Run 1 = 3.3.20 SC2 Run 1
NOTE: Base runs off available chip spots in room 3.

2. Log into SmarTerm and enter Function: MWS
[image: ]

3. Select 1 for Build Sequence Worksheets.
[image: ]

4. Select 1 for Build Sequence Worksheets Manually.
[image: ]

5. Enter past the Tech entry to enter your Worksheet as COVID

6. Enter past the Batch Number to have it automatically assigned sequentially.

7. Scan or manually type in CID barcodes to create your worksheet. 
[image: ]COVID


8. When done entering CID barcodes, push Enter and then Accept the batch list if correct by entering “A”. Your batch number will be assigned. Record this number.
[image: ]

9. Return to Function MWS and select 2 for Print Sequence Worksheets. 
               [image: ]

10. Enter your printer number (225 for the molecular printer). Select 1 for Sequence Worksheets. 
         [image: ]

11. Print an Incomplete worksheet by selecting 1 and then entering through until Worksheet appears. Enter COVID here and then the batch number. Then enter “A” for Accept. The incomplete worksheet will print. This is to be used for sample identification throughout testing.
[image: ]COVID



Extraction Method Selection
12. If the extraction run contains ≤22 samples, extract on the EasyMag.
 
13. If the extraction run contains ≥22 samples, extract on the KingFisher. 



Extraction on the EasyMag:
1. Position samples and controls in EasyMag extraction wells as follows:  
	Sample
	Position

	Patient samples
	Position 1-nn

	NC
	After last patient sample



2. Using the worksheet as a layout, organize patient specimens and labels

3. Number patients on worksheet and labels in consecutive order:
a. Number samples and labels according to extraction wells (GREEN) and amplication plate spots (PURPLE) marker
NOTE: write the sample type on the label
b. Scan labels according to their CID into the plate set up form (excel): MB 15.0.F6 Agena MassArray Plate Set-up, checking the PURPLE locations as you go.
NOTE: Each plate contains one positive control sample and one negative control sample. Label as “PC_1” and “NC_1”
c. Save file to:
i. G:\LAB\Molecular\Agena MassArray - infectious disease\SARS-CoV-2\SC2 Plate Set Ups by the experiment run name. 
ii. USB thumb drive by the experiment run name.  
d. Number each primary patient specimen for extraction according to worksheet 
e. Arrange samples in order in a rack 
f. Prepare 1.5 mL elution tubes with a patient label and the corresponding extraction run number
i. Write the extraction well number on the cap in  GREEN
ii. Label with patient label containing the amplification well plate number and sample type (e.g. A1, A2, A3, etc.) in  PURPLE
iii. Place elution tubes in a magnetic rack

4. Vortex patient samples and/or QC for 10 seconds.

5. Using 200 μL extended pipette tips, transfer 200 μL sample to the extraction tray well for the EasyMag. 
NOTE: Be sure to match sample numbers as specimens are transferred to the wells. Change gloves every 8 samples.

6. Set up the run:
a. Enter your protocol from the drop down box: RVP D 1.01.
b. Define extraction settings:
i. Volume (mL): 0.200 
ii. Eluate (µL): 60 
iii. Type: Primary 
iv. Priority: Normal
v. Matrix: Other 

7. Build a worklist:
a. In the Sample ID field, scan patient labels and controls in consecutive order; the carriage return and assignment to worklist will be automatic.
NOTE: If a sample ID is entered manually, press Enter after each manual addition to assign samples to the worklist.

8. Organize the run:
a. Add samples to the worklist by touching the Organize Runs icon [image: ]

9. Create the run:
a. Touch the New Run icon [image: ] to create a run name.  The date will default with a unique run modifier.
b. Select workflow options: 
i. On board lysis incubation [image: ]
ii. On-board silica incubation [image: ]
c. Touch OK
d. Sample positions are assigned when the samples are transferred to Run Layout using the arrow buttons.
i. NOTE: Refer to MB 4.03 NucliSens easyMag Procedure for additional icon details.
e. After samples are assigned a position, touch the Load Run icon [image: ].

10. Load the run:
a. Touch the Load Run icon and select the correct run from the dropdown menu if necessary (the last programmed run will automatically be displayed).
b. Snap the sample strips into the strip slots securely.
c. Scan the barcode on each strip then the position barcode (A, B or C).

11. Start the run: 
a. Touch the Dispense Lysis icon [image: ] to start the lysis.

12. Prepare the silica premix in a clean hood during lysis.  
a. Make a mixture of silica and NFW in a 1.5 mL cryovial by mixing according to the table below: 
NOTE: Vortex the silica 5 – 10 seconds prior to pipetting (each use).

	Number of Samples per extraction strip (including controls)
	Silica 
	NFW

	3
	238 uL
	238 uL

	4
	300 uL
	300 uL

	5
	363 uL
	363 uL

	6
	425 uL
	425 uL

	7
	488 uL
	488 uL

	8
	550 uL
	550 uL

	9
	620 uL
	620 uL

	10
	690 uL
	690 uL



b. Vortex the mixture well. 
c. Pipette 125 uL portions of the mixture into a sterile strip plate according to the number of samples in the extraction strip.

13. Thaw the MS2 phage internal control, vortex 3 -5 seconds, quick spin.
a. After lysis is complete, bring sample trays into hood and add 10 uL to each extraction well.
NOTE: Keep MS2 in a cold block. 

14. Add the premix to the lysed samples:
a. Open the EasyMag cover.
b. Transfer 100 ul of premix from the 8-well vessel to sample vessels containing the lysed samples using the BioHit pipette using the P3 setting. 
c. Fit the pipettor with the needed tips and then press the start button. 
d. Select P3 by pushing select until P3 is displayed. 
e. Thoroughly homogenize the mixture with the BioHit pipette by mixing twice with the P3 setting.
f. Return sample trays to the instrument.
g. Assign the Silica lot number to the sample locations 
i. Touch the Silica icon [image: ] and barcode the silica lot number (located on the silica box cover)
ii. Highlight the samples on the run list
iii. Touch the Add icon [image: ]
iv. Touch the Silica icon on the top bar to review the assignment
h. Return to the progress screen; Touch the Progress View icon  
 
 

i. Start the extraction by pressing the Start icon [image: ]

15. Complete the run and obtain the eluates:
16. After the run is finished, the hour glass will be idle
NOTE: transfer the extracted samples within 30 min to prevent silica contamination.
17. Print extraction report from the View Results screen [image: ], touch the Print icon [image: ].
18. Carefully remove the strips not to disturb the silica button.
NOTE: Check silica buttons; if not present, the extraction must be repeated.
19. Transfer the eluates with a 100 uL pipette set to 80 uL into corresponding 1.5 micro-centrifuge tube in a magnetic rack.
NOTE: Take care not to transfer any silica particles, since they may inhibit PCR amplification.
20. Allow eluate tubes to sit for 10 min prior to use.
NOTE: If the sample is contaminated with silica, retransfer into a clean tube and allow to sit in the magnetic rack.
21. If eluates are not going to be used immediately, store at 2 – 8 °C if testing that day or -70 °C if testing at a later date.

NOTE: Refer to MB 4.03 NucliSens easyMag Procedure for additional instrument details.


Extraction on the KingFisher:
1. Number patients on worksheet and labels in consecutive order:
a. Number samples and labels with the extraction plate and amplification plate well number (e.g. A1, A2, A3, etc.) with a PURPLE marker
b. Scan labels according to their CID into the plate set up form (excel): MB 15.0.F6 Agena MassArray Plate Set-up, checking the PURPLE locations as you go.
NOTE: Each plate contains one positive control sample and one negative control sample. Label as “PC_1” and “NC_1”
c. Save file to: 
i. G:\LAB\Molecular\Agena MassArray - infectious disease\SARS-CoV-2\SC2 Plate Set Ups by the experiment run name. 
ii. USB thumb drive by the experiment run name.  
d. Number each primary patient specimen for extraction according to worksheet 

2. Label the short side of each KingFisher Deepwell 96 Plate as follows:
	Label
	Number of Plates

	Samples: Experiment Name
	1

	Wash 1: Wash Buffer
	1

	Wash 2: 80% Ethanol 
	1

	Elution: Experiment Name
	1



3. Label the short side of the KingFisher 96 KF microplate as follows:
	Label
	Number of Plates

	Tip Comb
	1



4. Prepare the processing plates in the table below under the hood according to the run prep worksheet: MB15.0.F4 Agena MassArray SARS-CoV-2 Assay Run Prep Worksheet. Cover the plates with a temporary seal and then store at room temperature for up to 1 hour while you set up the sample plate.  Change gloves after prep of each plate. 
NOTE: 80% Ethanol should be made daily with nuclease free water.  See the run prep worksheet (1.5 mLper reaction for overage to be prepped).  Use a graduated cylinder with serological pipettes to prep, dependent on volumes. 

	Plate ID
	Plate Position
	Plate Type
	Reagent
	Volume per well
	Overage calculated in prep sheet

	Wash 1: Wash Buffer
	2
	KingFisher Deepwell 96 Plate
	Wash Buffer
	500 uL
	25%

	Wash 2: 80% Ethanol
	3
	
	80% Ethanol
	1,000 uL
	25%

	Elution Plate
	4
	
	Elution solution
	60 uL
	30%

	Tip Comb Plate
	5
	Place a KingFisher 96 tip comb for DW magnets in a KingFisher 96 KF microplate
	N/A



NOTE: Transfer liquids to reagent reservoirs using volumetric pipettes according to the run prep worksheet. 
NOTE: Use sterile 100 mL reagent reservoirs (or smaller if applicable) with multichannel pipettes to prep plates.  

5. Using volumetric pipettes, prepare the required amount of Binding Bead Mix in a labeled conical each day of use. 
NOTE: Precipitates can occur if the Binding Solution is stored when room temperature is too cold.  If there are precipitates, warm the Binding Solution at 37°C and gently mix to dissolve the precipitates.  Avoid creating bubbles.

For the number of required reactions, prepare the Binding Mix with the reagents listed in the table below according to MB15.0.F4 Agena MassArray SARS-CoV-2 Assay Run Prep Worksheet:
	Component
	Volume per well *

	Binding Solution
	265 μL

	Total Nucleic Acid Magnetic Beads
	10 μL

	Total Volume per Well
	275 μL


*Include 30% overage when making the Binding Bead Mix for use with multiple reactions.
NOTE: refer to the run prep worksheet 
NOTE: Prior to pipetting, vortex the Total Nucleic Acid Magnetic Beads 10 - 15 seconds to ensure that the bead mixture is homogenous.
NOTE: work under the hood.  If for any reason an alternative approach is taken, wear safety glasses for prep. 
NOTE: dispose of any reagent reservoirs or conicals with residual binding mix or beads into a labeled satellite waste/ biohazard container.  


6. Mix well by inversion, then store at room temperature. 

7. Aliquot the Proteinase K into 12 - 0.2 mL strip tubes and prepare the sample plate according to the run prep worksheet.  Quick spin the tubes.
NOTE: work under the hood.  If for any reason an alternative approach is taken, wear safety glasses for prep. 
NOTE: dispose of strip tubes with residual proteinase K into a labeled satellite waste/ biohazard container.  

8. Using the 5 -50 uL multichannel pipette (125 uL tips), add 5 μL of Proteinase K to each well of the sample plate that will be used for processing in the KingFisher Deepwell 96 Plate (15% overage on run prep sheet).  

9. Vortex patient samples and/or QC for 5 - 10 seconds.

10. Using extended tips, add 200 μL of sample to each sample well. 
a. Change gloves after addition of 12 samples. 

11. Invert the Binding Bead Mix 5 times to gently mix and pour into a sterile reagent reservoir – try to avoid bubbles. Then add 275 μL to each sample well.

a. Remix Binding Bead Mix by inversion frequently during pipetting to ensure even distribution of beads to all samples or wells. Pipette slowly to ensure the correct amount is added. 
NOTE: Do not reuse pipette tips to add Binding Bead Mix.  Change tips after each addition.
NOTE: Gently swish and swirl the reagent reservoir before each pipette.
NOTE: dispose of any reservoirs with residual binding mix or beads into a labeled satellite waste/ biohazard container.  
 

12. Vortex 2-3 seconds, quick spin, and aliquot the MS2 into 12 - 0.2 mL strip tubes according to the run prep worksheet (20% overage).  Quick spin the strip tubes.
a. Keep MS2 in a cold block while it is out of the freezer. 

13. Using the 5 -50 uL multichannel pipette (125 uL tips), add 10 μL of MS2 to each well that will be used for processing in the KingFisher Deepwell 96 Plate.
NOTE: Change tips after each addition

14. Using the arrow on the keypad, tab over to the orange tab on the KingFisher.  Select RNA and the MVP_2Wash_200_Flex for the KingFisher Flex Magnetic Particle Processor with 96 Deep-Well head. 

15. Start the run, then load the prepared plates into position when prompted by the instrument (press START once loaded). 
NOTE: Place the A1 well of the plate so that it is in the upper right corner.
NOTE: The tip comb always has to be placed manually onto a KingFisher plate. 
NOTE: The loading position is plate station 4. The 8 plate stations and the A1 positions are clearly marked.
NOTE: The tip comb is automatically locked onto the tip comb holder from the tip-plate.

[image: ][image: ][image: ]


16. Once the plates are loaded, and the sliding door is closed, press START. 

17. After the run is complete (~22 minutes), immediately remove the Elution Plate from the instrument, and then cover the plate with an Adhesive Foil Sheet.
NOTE: If eluates are not going to be used immediately, store at 2 – 8 °C if testing that day or -70 °C if testing at a later date.


18. After the run, remove the plates according to the protocol request. Confirm each plate removal by pressing the START key. Remove the sample plate first.

19. Press STOP after completing the run.

20. Place the tip comb, tip comb microplate, and wash plates in a zip-lock bag.  Discard as hazardous waste.  Place the sample plate in a zip-lock bag and dispose of as satellite/hazardous waste.  Clean the instrument after each use using 5% extran and 80% ethanol.   
NOTE: After use, store elution plates with a foil seal at -70°C



	Assay Procedure: RT-PCR Master Mix Preparation (Room 1):
	
1. Clean hood with 5% Extran followed by 70% ethanol.

2. Prepare your Master Mix run worksheet: 
a. MB15.0.F4 Agena MassArray SARS-CoV-2 Assay Run Prep Worksheet
NOTE: reagent volumes allow for 25% overage

3. Pull the reagents listed in the Table below to thaw to room temp.  Vortex all except the enzymes (flick) and quick spin.  
NOTE: Leave enzymes (MMLV, UNG, and PCR Enzyme) in the freezer until use, and keep in a cold block when pipetting.

4. Prepare the RT-PCR master mix (cocktail) in a labeled 1.5 mL tube in a cold block by adding reagents in order, as listed in the table below. Write how many tests are being removed on the white board in room 1. When opening a new box, write the numbers 1 through 8 on top of each vial as corresponds to the table below. 

	Reagent	
	Per Reaction (uL)

	1. 10X PCR Buffer
	0.500

	2. MgCl2, 25 mM
	0.400

	3. dUTP/dNTP Mix
	0.100

	4. UNG (heat labile) Enzyme
	0.050

	5. RNase Inhibitor
	0.125

	6. SARS-CoV-2 Panel PCR Primers
	0.500

	7. PCR Enzyme
	0.200

	8. MMLV Enzyme
	0.125

	RT-Cocktail Final Volume
	2.000

	Sample RNA/Positive Control/Negative Control
	3.000

	RT-PCR Reaction Final Volume
	5.000




NOTE: reagent volumes on the worksheet allow for 25% overage


5. Pulse vortex the tube briefly 3 times and quick spin.  Place tube back in cold block.  

6. If testing 12 or more total samples (including QC), divide to total volume of master mix by 12 and… aliquot into 12 - 0.2 mL PCR strip tubes (strip of 8 + 4 – cut one in half to make a strip of 12).  Quick spin tubes before moving to room 2.
NOTE: The worksheet calculates volumes accordingly 
 
7. Bring the Master Mix in the cold block into room 2 for dispersal and sample addition.
NOTE: If for any reason transfer of the master mix is delayed, place the entire block in the fridge.

NOTE: Leave MB15.0.F4 Agena MassArray Run Prep Worksheet in Room 1 for SAP and iPLEX Pro Extension Cocktail prep below. 

NOTE: Sample extract may be added to plate prior to master mix if preferred for optimal work-flow.  (Freeze at -70 °C).

	Assay Procedure: 
RT-PCR Master Mix Dispersal and Sample Addition (Room 2)

	

1. Label a 96 well plate with the date and run number according to your worksheet.  Place in cold block. 

2. Dispense 2.0 uL of the RT-PCR Master Mix into each well of a new microtiter plate using the Integra pipet with a tip space of 9 (set on the Pipet option). 

3. Add 3.0 uL of either sample or control RNA to each well of the plate with master mix.
NOTE: pipette pos and neg controls with a single channel pipette.  Positive before the negative at the end of the run.  
NOTE: do not vortex synthetic RNA pos QC.  Thaw and quick spin only. 
NOTE: for KingFisher extractions, use 12.5 uL extended tips for transfer.  Set plate on tilt table and angle the pipette tips towards the front of the wells.  Ensure NO residual magnetic beads are pulled up when transferring. 
NOTE: Check the worksheet and patient labels as samples are pipetted into wells.
NOTE: Change gloves after handling of 8 samples from EasyMag. 

4. Seal the RT-PCR reaction plate, briefly pulse vortex 1-2 times, then do a quick spin on the centrifuge by bringing up to 1200 rpm. 
NOTE: Crease all four sides with the paddle. 

5. Visually inspect the individual wells from the bottom of the reaction plate to confirm uniform and adequate master mix solution is present in every well before continuing. 

6. Place the plate in the cold block and move to Room 3 to start thermal cycling.


	Assay Procedure: RT-PCR Amplification (Room 3)
	
NOTE: Turn on the thermal cycler so that the heated cover can come to the correct operating temperature and there is no time delay between the RT-PCR reaction plate being prepped and cycling being started. 

1. Place plate in the thermocycler (rotate usage).  Run program sc-rt-pcr.  See the Table below for program details.   
NOTE: Total volume: 5 uL
NOTE: Cycle program takes approximately 1 hour and 45 minutes 
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NOTE: If not proceeding directly to the next step, the reaction plate should be sealed and stored at 4 °C – 10 °C  (if storing for less than 24 hours), or at -20 °C (if storing for more than 24 hours).  Do not store for more than 2 weeks. 


	Assay Procedure: Shrimp Alkaline Phosphatase (SAP) Cocktail Preparation (Room 1)
	
1. Pull the reagents listed in the Table below to thaw to room temp.  Vortex all except enzymes (flick) and quick spin.  
NOTE: Leave enzymes in the freezer until use, and keep in a cold block when pipetting.

2. Prepare the SAP cocktail in a labeled 1.5 mL tube in a cold block by adding reagents in order, as listed in the table below. 

	Reagent
	Per reaction (uL)

	1. HPLC-grade water
	1.53

	2. SAP Buffer
	0.17

	3. Shrimp Alkaline Phosphatase (SAP)
	0.30

	SAP Cocktail Final Volume
	2.00



[image: ]
NOTE: reagent volumes on the worksheet allow for 25% overage

3. Pulse vortex the tube briefly 3 times and quick spin.

4. If testing 12 or more total samples (including QC), divide to total volume of master mix by 12 and… aliquot into 12 - 0.2 mL PCR strip tubes (strip of 8 + 4 – cut one in half to make a strip of 12).  Quick spin tubes before moving to room 3. 
NOTE: The worksheet calculates volumes accordingly

5. Immediately bring to Room 3 and place in cold block. 

NOTE: Leave MB15.0.F4 Agena MassArray Run Prep Worksheet in Room 1 for iPLEX Pro Extension Cocktail prep below.


	Assay Procedure: SAP Cocktail Addition to Samples (Room 3)
	NOTE: If plates  were stored frozen prior to this step, make sure they are thawed completely, gently homogenized, spun down, and kept in a cold block

NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by water and alcohol before and after adding the cocktail 

1. Perform a quick spin of the RT-PCR reaction plate on the centrifuge by bringing up to 1200 rpm.

2. Remove and discard seal.  Change gloves.  
NOTE: Take care when removing seal: do not let it curl back onto the plate or fold into itself. 

3. Dispense 2 uL of SAP cocktail into each well of the reaction plate. 

4. Seal the reaction plate, briefly pulse vortex 1-2 times, then perform a quick spin on the centrifuge by bringing up to 1200 rpm.
NOTE: Crease all four sides with the paddle.

5. Visually inspect the individual wells from the bottom of the reaction plate to confirm uniform and adequate solution is present in every well before continuing.  

6. Place the plate in the thermocycler and run program sc-sap.  See the table below for program details.
NOTE: Total volume: 7 uL
NOTE: Cycle program takes approximately 15-20 minutes
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NOTE: If not proceeding directly to the next step, the reaction plate should be sealed and stored at 4 °C – 10 °C  (if storing for less than 24 hours), or at -20 °C (if storing for more than 24 hours).  Do not store for more than 2 weeks. 


	Assay Procedure: iPLEX Pro Extension Cocktail Prep

	
1. Pull the reagents listed in the Table below to thaw to room temp. Vortex all except enzymes (flic) and quick spin. 
NOTE: Leave enzymes in the freezer until use, and keep in a cold block when pipetting.

2. Prepare the iPLEX Pro Extension cocktail in a labeled 1.5 mL tube in a cold block by adding reagents in order, as listed in the table below. 

	Reagent
	Per reaction (uL)

	1. HPLC-grade water
	0.62

	2. iPLEX Buffer Plus, GPR
	0.20

	3. iPLEX Termination Mix
	0.20

	4. SARS-CoV-2 Extend Primer
	0.94

	5. iPLEX pr Enzyme
	0.04

	Extension Cocktail Final Volume
	2.00




NOTE: reagent volumes on the worksheet allow for 25% overage

3. Pulse vortex the tube briefly 3 times and quick spin.

4. If testing 12 or more total samples (including QC), divide to total volume of master mix by 12 and… aliquot into 12 - 0.2 mL PCR strip tubes (strip of 8 + 4 – cut one in half to make a strip of 12).  Quick spin tubes before moving to room 3.
NOTE: The worksheet calculates volumes accordingly

5. Immediately bring to Room 3 and place in cold block. 


	Assay Procedure: iPLEX Pro Extension Cocktail Addition to Samples (Room 3)

	
NOTE: If plates  were stored frozen prior to this step, make sure they are thawed completely, gently homogenized, spun down, and kept in a cold block

NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by water and alcohol before and after adding the cocktail 

1. Perform a quick spin of the RT-PCR reaction plate on the centrifuge by bringing up to 1200 rpm.

2. Remove and discard seal.  Change gloves.
NOTE: Take care when removing seal: do not let it curl back onto the plate or fold into itself. 

3. Dispense 2 uL of extension cocktail into each well of the reaction plate.
 
4. Seal the reaction plate, briefly pulse vortex 1-2 times, then perform a quick spin on the centrifuge by bringing up to 1200 rpm.
NOTE: Crease all four sides with the paddle.

5. Visually inspect the individual wells from the bottom of the reaction plate to confirm uniform and adequate solution is present in every well before continuing.  

6. Place the plate in the thermocycler and run program sc-extension.  See the table below for program details.
NOTE: Total volume: 9 uL
NOTE: Cycle program take approximately 65 minutes
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NOTE: If not proceeding directly to the next step, the reaction plate should be sealed and stored at 4 °C – 10 °C  (if storing for less than 24 hours), or at -20 °C (if storing for more than 24 hours).  Do not store for more than 2 weeks. 


	Assay Procedure: Water Addition (Room 3)
	
NOTE: If plates were stored frozen prior to this step, make sure they are thawed completely, gently homogenized, spun down, and kept in a cold block

NOTE: Clean hood and supplies with a 1:10 bleach dilution or wipes followed by water and alcohol before and after adding the cocktail 

1. Perform a quick spin of the RT-PCR reaction plate on the centrifuge by bringing up to 1200 rpm.

2. Discard and remove seal.  Change gloves.  Add 41 uL HPLC-grade water to each well of the reaction plate. 
NOTE: Take care when removing seal: do not let it curl back onto the plate or fold into itself. 

3. Seal the plate and perform a quick spin of the RT-PCR reaction plate on the centrifuge by bringing up to 1200 rpm.
NOTE: Crease all four sides with the paddle.

NOTE: If not proceeding directly to the next step, the reaction plate should be sealed and stored at 4 °C – 10 °C  (if storing for less than 24 hours), or at -20 °C (if storing for more than 24 hours).  Do not store for more than 2 weeks. 


	Preparing a run file (sample group)
	
1. Insert thumb drive with the run file into the Agena MassArray computer. 
i. Open the file and select the CIDs
ii. Copy and paste and CIDs into a notepad document and save in the documents folder as the experiment/run name 
NOTE: remove any extra characters after the last sample 
NOTE: file must be saved as a .txt file 


	Creating a plate in the MassArray Software 
	

Create a Sample Group 
1. Open the MassARRAY Typer Plate Editor software, log in. 
a. User: charles
b. Password: darwin

2. Click on the Sample view tab.

3. Expand the customer and project.  Right-click on the sample project that you want to add the sample group to and select Add New Sample Group.

4. Enter the Experiment/Run name and click the folder button in the toolbar to browse to the location of your sample group text file, and click Open, then click OK.
NOTE: properties – select “Horizontal” and “Keep Selected Region True”

Create a Project & Plate
1. In the MassARRAY Typer Plate Editor software click on the Plate tab.

2. Create a plate.
a. Right-click on the project that you want to add the plate to and select New Plate.
b. Enter the Experiment/Run name and select the plate type (96- or 384-well) and click OK.
c. The new plate will appear in the Plate tab and a plate layout will be created automatically, based on the plate type specified.

Apply Assays to the Plate
1. In the Plate tab, select the plate that was just created.

2. Select the Assay tab and in the plate layout, select the wells of interest.

3. Expand the the SC2 assay design file (SC2_ADF.tsv).

4. Right click on the test tube “1” icon and select add plex 1.

Apply Samples to the Plate
1. Click on the Sample tab.

2. In the plate layout, select the wells of interest.

3. Right-click the sample or sample group that you want to assign to the selected wells and select Apply Samples from Group or Add Sample.

4. Select File > Save from the toolbar.


	Assay Procedure: Creating an Input File (Room 3)
	
1. Double-click the Chip Linker icon on the desktop.

2. In the dialog box that appears, enter your username, password, and server.
a. User: Charles
b. Password: darwin

3. Click Connect. The Chip Linker window appears.

4. Select a plate in the Chip Linker directory tree.

5. Select iPLEX as the terminator chemistry.

6. Select Genotype+Area for the process method.

7. Select Nanodispenser 96 to 96 as the dispenser method.

8. Enter the Experiment/Run name.

9. Enter the SpectroCHIP Array barcode or other SpectroCHIP Array identifier.

10. Click Add. The input information appears in the Chip Linker table.

11. If a second SpectroCHIP Array will be processed, repeat step 4 to step 10 for the second SpectroCHIP Array.

12. Click Create to create an input XML file. This file will be selected for use when you set up the automatic run.


	Assay Procedure: Preparing the Instrument (Room 3)
	
NOTE: Ensure the daily maintenance has been performed prior to advancing. 

1. In the Status section in the Run Setup tab of SpectroACQUIRE check the Waste Tank, System Fluid, and Resin buttons; they should be green/Okay. If any are red (Waste Tank Full, System Fluid Empty, Resin Low or Empty) perform the necessary maintenance.

2. Click Chip prep module Deck In/Out at the top of the SpectroACQUIRE window. The deck will extend.

3. If there are SpectroCHIP Arrays in the completed chips position on the deck remove them.
NOTE: the completed position is the deck that is closer to you

4. Allow the calibrant to equilibrate to room temperature for 5 minutes (if it has been refrigerated) or 10 minutes (if it has been frozen). Quick spin and pipette 75 μL of calibrant into the calibrant vial and place in the calibrant vial holder on the deck.

5. Load the SpectroCHIP Arrays.
a. Orient the Chip holder so that the bevelled corner is at the top right.
b. Open a new SpectroCHIP Array pouch and insert the new SpectroCHIP Array into the chip holder in position 1 (on the left); orient the SpectroCHIP Array such that the Agena logo and barcode are at the bottom. Make sure that the SpectroCHIP Array is properly seated so that the chip holder and SpectroCHIP Array surface are flush.
NOTE: Use flat tweezer for transfer and pointed tweezer for any necessary adjustments 
NOTE: Care must be taken to avoid touching the surface
NOTE: Chips may be sent on counter on top of a kim wipe 
NOTE: Cave the SpectroCHIP Array pouch and holder if chip will not be completely used.  Write the open date on the pouch. 
c. If you are processing two plates, insert another new SpectroCHIP Array into the chip holder in position 2 (on the right). If you are only processing one plate, place a previously completed SpectroCHIP Array in position 2, as the MassARRAY Analyzer requires both SpectroCHIP Array positions to be filled to function properly.
d. Place the full chip holder in the chip holder tray, new chips position, on the deck.

6. Load microtiter plates (MTPs). Up to two 96-well microtiter plates of analyte may be loaded.
a. Quick spin the microtiter plate(s) at ~1200 – 1500g
b. Remove the seal, change gloves, and place the first MTP on MTP holder 1 (on the left). This corresponds to chip position
i. Orient the plate such that well A1 is in the front left corner (match to label on instrument loading deck)
c. If a second MTP is being processed, place it on MTP holder 2 (on the right). This corresponds to chip position 2.

7. Click Chip prep module Deck In/Out again to retract the deck.


	Assay Procedure: Setting up and Starting the Run (Room 3)
	
1. Select the Run Setup tab in SpectroACQUIRE.


2. In the Analyzer Setup section:
a. Select Tools > Load Parameters on the SpectroACQUIRE toolbar, then select the appropriate parameter file based on the SpectroCHIP type (iplex_CPM.par). Acquisition parameters will automatically populate.
b. In the Experiment Setup section:
i. Under MTP 1, click on the browse button next to Experiment Name and select the XML input file created earlier.
ii. In the Wells to Process field, select Automatic.
iii. Repeat steps 1 and 2 for MTP 2 if running two plates. Otherwise, select None in the Experiment Name and Wells to Process fields for MTP 2.
c. Make sure all settings are as shown in the Table below.

	
	SpectroCHIP CPM-96

	Use Autotune
	NOT selected

	Start Dispense Condition
	600

	Resin Volume
	13

	Sample Volume
	n/a

	
	

	Shots (n)
	30

	Maximum acquisitions
	9

	Minimum good spectra
	5

	Maximum good spectra
	5

	Turn off HV After Analysis
	Selected

	Analyze Calibrant Pads
	Selected

	Filter Saturated Shots
	NOT selected

	Chip Type
	SpectroCHIP CPM-96




3. In the Chip Prep Module Setup section:
a. Check the Normal Operation box.
i. If NOT running 2 plates: unselect “Transfer Resin to MTP2”
NOTE: if rerunning a plate that has already been spotted unselect “Transfer Rein to MTP1 and/or MTP2”
b. Select iPLEX in the Chemistry drop-down menu.

4. In the Temperature Control section:
a. If the run will sit on the instrument overnight, select the MTP Cool box, and check the Auto box.
b. If using a SpectroCHIP CPM-96, check the Chip Heat box and enter 30 in the Setpoint field.

5. Click Start Chip prep module to start the run.


	Assay Procedure: Removing plates, calibrant and SpectroCHIP Array when run is complete 
	
1. Once the run is completed, click Chip prep module Deck In/Out to move the deck out and remove the MTPs and calibrant vial. Store remaining calibrant refrigerated or frozen for future use.
a. Pipette remaining calibrant into a 2 mL cryovial labeled with the clibrant lot number, expiration date, and date the vial was created
b. Rinse calibrant tube with DI water:
i. Pipette 100 uL DI water and mix 5-8 times 

2. Click Remove Old Chips from MA4 in the Run Setup tab. The instrument will move the completed SpectroCHIP Arrays from the MassARRAY Analyzer to the completed chips position on the Chip Prep Module deck, and then extend the deck so you may remove the SpectroCHIP Arrays from the completed chips position.
NOTE: save incompletely used chips in saved holder and pouch with the desiccant.  Write the open date and which wells have been used on the outside of the pouch. Seal with tape.  

3. Click Chip prep module Deck In/Out to move the deck in.  


	Analyzing Data 
	
1. Open MassARRAY Typer Analyzer.  
a. Login:
i. User: charles
ii. Password: darwin
2. In the Project Explorer pane double click on the SpectroCHIP Arrays of interest. The SpectroCHIP Arrays will be added to the Chip List.

3. Load the SpectroCHIP Arrays by checking the box next to the SpectroCHIP Array names in the Chip List.

4. Check for calls in the box that summarizes the total calls in the report (in the “assay summary” tab in the lower left side of the window), if there is more than one aggressive call:
a. Go to View -> plater data pane
b. Sort the calls by description
c. If ONE sample has >1 aggressive calls, repeat the sample (see table below) 

5. Select File > Reports > SC2 Report-v1 in the MassARRAY Typer Analyzer menu bar.

NOTE: When the report is complete, the SC2ReportDetails.csv will automatically open, and the
results will be made available in a date- and time-stamped folder in the Typer/bin/
TyperReports/SC2 Report folder in the C drive under MassArray.
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6. Save the result file to a USB thumb drive:
a. Arrange the samples so that they are in the order of the wells by highlighting the plate locations and clicking the A->Z icon on the top of the page.  Expand the entire selection. 
b. Select File, save as, and save to thumb drive with the experiment name.  
i. Select to save in ODF format to create an .ods file
 

7. Save results to monthly folder located here:   G:\LAB\Molecular\Agena MassArray - infectious disease\SARS-CoV-2\RESULTS

8. Print results. 
a. Condense columns where possible
b. Select the region to print
c. Select Add All borders
d. File -> print
e. Margins: Narrow
f. Fit all columns on one page 
 

	
	

	Result Interpretation
	
Interpretation of the results is performed by the Agena Bioscience SC2 Report software.

Quality control and validity of results
1. One negative control with MS2 and one positive synthetic RNA amplification control are processed with each run.
NOTE: If either control fails, samples must be extracted again with new controls, and the run repeated. 

2. Validation of results is performed automatically by the Agena Bioscience SC2 Report software based on performance of the positive and negative controls.  See the Table below for Result Interpretation. 


	Result
	Interpretation
	Notes
	Action

	Detected
	Indicates the presence ≥ 2 SARS-CoV-2 targets in the sample 
	MS2 detection not required for a valid result
	Report Results

	Not Detected
	Indicates the absence of ≥ 2 SARS-CoV-2 targets in the sample
	MS2 detection required for a valid result 
	Report results

	Inconclusive
	Indicates 1 SARS-CoV-2 target was detected
	MS2 may or may not be detected
	Repeat testing on original sample. If secondary results in inconclusive, report as such. 


	Invalid
	Indicates the inability to determine the presence or absence of the SARS-CoV-2 targets in the sample
	MS2 not detected. 
Results may be due to:
1. Internal Control failure 

	Repeat testing from original sample.  If secondary results is invalid, report as such. Call caregiver to notify. Document in problem log. 

	Invalid QC Results

	Indicates an error for the particular analyte(s).
	Results may be due to:
1. Internal Control failure (MS2 not detected) 
2. Sample contamination 
3. Control prep error 


	Repeat testing.  

If Pos Amplification control failed:
Repeat testing on extracts with valid MS2 results.

If Low Pos is not detected or has an MS2 failure: 
Repeat run from another aliquot.  

If Neg QC is positive or has an MS2 failure (Invalid):
Repeat run from original samples and perform wipe testing.


Document in problem log. 


	Aggressive calls
	Indicates a possible issue with the call
	Results may be due to:
1. Sample contamination
2. Assay performance 
3. Consumable faults 
	Repeat testing on samples with >1 aggressive calls (see notes above).  Contact technical support for recommended actions if the sample repeats the same. 

	System Error
	
	
	Follow directions given by software, repeat testing if necessary.  If needed, contact Agena Bioscience technical support 
1-858-882-2800
Help Desk: 1-858-882-9300
Email: helpdesk@AgenaBio.com

Document in problem log.




NOTES on well colors:
There are 6 assays in each well.  The color shown in the typer software relates to the number of targets that were called (AKA: performed).  
Green = 85% or more called (6 of 6 called)
Light Green = 84 – 50% called (4 or 5 of 6 called)
Yellow = 49% - 16% called (1 or 2 of 6)
Red = 15% or less called (0 of 6)


	Raw Data Review 
	
To review any questionable results or additional run data:

1. In the Typer Analyzer software select the chip. 

2. Go to file -> view details pane to review spectrums.
a. Red text indicates the primer peak for the Gene.
i. A large peak here indicates that the primer was not extended during the PCR reactions (large peak = gene NOT present in the sample).
b. Blue text indicates the call region for the detection of extended primers and nucleic acid tags (A, C, T, or G) associated with the gene (large peak = gene present in the sample).
c. Gray text indicates the region’s association with a different gene, and will change to red or blue when a different gene is clicked on for review.

3. If you would like to review Assay calls, select View -> Plate Data Plan for raw data on calls. 


4. To view how an assay (marker) performed throughout the entire chip run: go to view -> cluster plot
a. Red markers = not detected/negative calls
b. Blue markers = detected/positive calls 



	
Printed run Report Review 
	
1. Highlight positive samples on SC2 report and run worksheet. 
2. Match samples to labels and mark labels as positive. 
3. Repeat process for invalid and/or inconclusive results.


	Result Reporting: Sunquest 
	
1. Remove any samples that need to be repeated from your manual worklist (first time inconclusives or invalids). 
1. Open the Build Worksheet function in the “roll and scroll” screen. 
1. Ender the worksheet (COVID) and batch number.
1. Identity the position of the sample that needs to be removed from the worklist.
1. Type “M-“ and the position number of the sample.
4. NOTE: you can select multiple samples by adding the position numbers and separating with a comma (e.g. M – 1,2,3,4…)
1. Verify that the correct sample number was identified by checking the accession and CID numbers across labels and paperwork. 
1. Type “-“. 
1. Press enter and accept to remove the sample(s) from the worklist. 
1. 
Open Result Entry. 
1. Select Manual resulting mode in the upper left corner. 
1. Select the worksheet configuration: COVID and the worksheet Batch #.
                                          [image: ]
1. Click on the Default Results tab. 
11. Under the Test column enter: SACOR
11. Under the Result column enter: NEG
                            [image: ]
1. Click result to open the resulting window.
1. Click on the binoculars located at the bottom of the window.
13. Using the marked labels, scan positive samples and enter POS

b. Using the marked labels, scan invalid and/or inconclusive results and enter results according to the Resulting Table below. 

NOTE: Check labels again SC2 run report file print out as results are entered
                  [image: ]

CHECK RESULTS AGAINST WORKSHEET AND LABELS BEFORE PROCEEDING TO THE NEXT STEP. 

7. Click Save in the lower right hand corner to very results. 

8. Click on Apply Defaults to result the rest of the samples as NEG. 
                                 [image: ]


4. Select Save in the lower right hand corner. 

Resulting Table
	Agena Software Interpretation
	Result Codes to Enter	

	Not Detected
	NEG
SC2

	Detected
	POS
SURE
SC2

	Inconclusive (report as inconclusive after results is obtained twice)
	ICLR
INCCO
SC2

	Invalid (report as invalid after result is obtained twice)
	IVALR
INVCO
RP
; person called to, credentials, date & time
SC2



NOTE:  the SC2 comment will append to all results:  Modified FDA Emergency Use Authorization: The performance characteristics of this SARS-CoV-2 RT-PCR/MALDI-TOF test have been determined by the Children's Minnesota Laboratory.


SURE: Semi urgent result  

Inconclusive results, comment, INCCO: The sample may have a very low level of SARS-CoV-2 RNA or a variant strain. Consider repeat testing on a new sample, if clinically indicated. 

Invalid results, comment, IVALR: The presence or absence of SARS-CoV-2 could not be determined, possibly due to RT-PCR inhibition. Submission of a new sample for testing is recommended. 



7. Print a completed worksheet from the MWS function in SmarTerm
a. Select 2 for Print Sequence Worksheets 
[image: ]
b. Select 1 for Sequence Worksheets and 2 for Complete to print the completed worksheet. Enter through until Worksheet is displayed and enter COVID. Then enter the batch number. Enter “A” for Accept to print the completed worksheet to the designated printer.
[image: ]COVID

c. Highlight positive samples and check against the printed SC2 run report file. 
8. File Worksheets and results in binder. 



	Correcting Results
	
1. Open Result Entry, select the Manual resulting mode (top left corner), from the configuration drop down select the appropriate test code.  Click [image: ] in the lower right corner. 
1. Enter the Specimen ID, enter Tab and click Yes to modify the result.
1. Change the incorrect result.  The corrected result comment will automatically append.  Add the RP comment, press tab, enter a semi-colon and record who was called and the time/date.
1.  Click [image: ].  Click [image: ] when the “Verify Release Destination” window opens.


	Sample Storage
	
Storage and Retention of Test Specimens
1. Mark all positive samples and extracts on cap (EasyMag). 
a. Write positive results on the side of the tube
2. Use aluminum seal to cover and store KingFisher elution plates. 
3. Store in rack in the -70 °C freezer for a minimum of 1 month.   
4. Discard samples after elapsed time in red biohazard container



	Equipment and Room Decontamination
	Refer to: 
MB 3.03 Cleaning and Decontamination of Equipment and Work Areas

	
Limitations

	
1. The performance characteristics of the MassArray SARS-CoV-2 panel have been evaluated by Children’s MN Laboratory. 

2. This assay may not be able to differentiate newly emerging SARS-CoV-2 subtypes.

3. Analyte targets (viral sequences) may persist in vivo, independent of virus viability.

4. Detection of analyte target(s) does not imply that the corresponding virus(es) are infectious or are the causative agents for clinical symptoms.

5. All results from this and other tests must be considered in conjunction with the clinical history, epidemiological data, and other data available to the clinician evaluating the patient.

6. Samples must be collected, transported, and stored using appropriate procedures and conditions. Improper collection, transport, or storage of samples may hinder the ability of the assay to detect the target sequences.

7. The performance of the SARS-CoV-2 Panel was established using nasopharyngeal swabs (NP) and Nasal (NA, Anterior Nares) samples.

8. This test is a qualitative test and does not provide the quantitative value of detected organisms present.

9. There is a risk of false positive values resulting from:
a. Cross-contamination by target organisms, their nucleic acids or amplified product, or from non-specific signals in the assay.
b. Cross-contamination during sample handling or preparation.
c. Cross-contamination between patient samples.
d. Sample mix up.
e. RNA contamination during product handling.

10. There is a risk of false negative values due to:
a. The presence of sequence variants in the pathogen targets of the assay, procedural errors, amplification inhibitors in samples, or inadequate numbers of organisms for amplification.
b. Improper sample collection.
c. Sample mix up.
d. Degradation of the SARS-CoV-2 RNA during shipping/storage.
e. Sample collection does not collect SARS-CoV-2 RNA.
f. The presence of RT-PCR inhibitors.
g. Mutation in the SARS-CoV-2 virus.

11. This test cannot rule out infections caused by other viral or bacterial pathogens not present on this panel.

12. The impacts of vaccine, chemotherapeutic or immunosuppressant drugs have not been evaluated.

13. Negative results do not preclude infection with SARS-CoV-2 virus, and should not be the sole basis of a patient management decision.

14. This panel has been evaluated for use with human sample material only.

15. The performance of this test has not been evaluated for monitoring treatment of infection.

16. Upon completion of an In silico cross-reactivity analysis, it was determined that four assay components (N1 x2, N2, and ORF1ab) exhibited >80% homology to SARS-coronavirus. However, the risk of non-specific PCR amplification of SARS-coronavirus is low. 



	
Method Performance Specifications

	
In-house performance (per the assay validation studies): 2x2 Table, Nasal and NP Samples – overall arbitrated results
	Agena
	Expected result

	
	Positive 
	Negative

	Positive 
	37
	1

	Negative
	0
	42



Results (95% CI): 
Positive Percent Agreement: 100% (90.51% - 100.00%)
Negative Percent Agreement: 97.67% (87.71% - 99.94%)
Overall Percent agreement: 98.75% (93.23% - 99.97%)

LoD (upper respiratory matrix): 0.02 TCID50/mL
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	Alternate Methods
	
1. In house: SARS-CoV-2, Molecular Detection, RT-PCR (Test code: COVC)
2. Send out test to Mayo Clinic Laboratories: COVID-19, Molecular Detection, RT-PCR, Varies (Mayo lab test code: COVID, SCOV2)
3. Send out test to Quest Diagnostics: SARS-CoV-2 PCR (Quest lab test code: COVO)
4. Send out test to MDH: SARS-CoV2/COVID-19, Molecular Detection, RT-PCR (MDH test code: COVS)


	Proficiency Testing
	
CAP (COV2): 2 shipments a year with 3 samples 


	
Training Plan/ Competency Assessment

	Training Plan
	Initial Competency Assessment

	
	1. Employee must read the procedure.
1. Employee will demonstrate the ability to perform procedure, record results, and document corrective action after instruction by the trainer.
	1. Direct observation

	Historical Record
	
	
	
	

	
	Version
	Written/Revised by:
	Effective Date:
	Summary of Revisions

	
	1
	Julie Laramie
	11/25/2020
	Initial Version

	
	2
	Julie Laramie
	12/14/2020
	-Added RNA amplification control, removed stock culture pos QC 

	
	3
	Julie Laramie
	02/01/2021
	-removed notes on probability interpretations

	
	Archived by:
	
	Archived date:
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